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COPYRIGHT 
Copyright © Datamed LLC. All rights reserved. Reproduction in whole or in part is prohibited without 
the prior written consent of the copyright holder. 
 
WARRANTY 
Datamed LLC (“DLLC”) makes no warranty of any kind with regard to this material, including, but not 
limited to, the implied warranties of merchantability and fitness for a particular purpose. The software 
described herein is covered by DLLC’s standard EULA, which is available on DLLC’s website 
(www.datamed.com). 
 
CAUTIONS 
This product is not intended for home use. 
 
REGULATORY 
This product is not a medical device.  
 
IMPORTANT LINKS 
System Requirements  
End-User License Agreement  
Support & Maintenance Plan Description 
 
 
 
 
 
 

Manufactured and Distributed by: 
Datamed LLC 
Brentwood, TN 
USA 
US: +1 800 601-3361 
Int’l: +1 901 672 6225 
Fax: +1 901 672 6331 
www.datamed.com 

 
 
 
  

http://www.datamed.com/
https://datamed.com/wp/?page_id=42
https://datamed.com/docs/datamed_eula.pdf
https://datamed.com/docs/datamed_smp_description.pdf
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TRADEMARKS 
The following marks are the registered trademarks of their respective owners. These marks are used for 
informational use only and do not imply any endorsement or approval by their respective owners. 

Owner Trademark(s) 
Datamed LLC Datamed 

Microsoft Corporation Microsoft and Windows Server 

National Electrical Manufacturers Association Corporation DICOM 

SafeNet Data Security Ltd. HASP 
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INTENDED USE 
 
This product is a software application intended to transmit files in DICOM® format to a 
destination server that accepts a C-STORE transaction in the DICOM® transmission 
protocol. This product does not alter the transmitted data in any way. It is not 
intended to be used for any other purpose and attempting to use it for any other 
purpose is a violation of the EULA. 
 
 
 
 

PROTECTED HEALTH INFORMATION (PHI) CONSIDERATIONS 
 
The file that is transmitted by this product may or may not contain PHI. As this 
product does not interact with the contents of the file except to read it from a folder 
and transmit it, no data from the file is written to the log. If the file contains PHI 
then appropriate measures should be taken to ensure the security of the file. When 
planning the physical and electronic security of the installation, it is important to be 
aware of this data and plan accordingly. PHI may appear in the following locations: 

• Debug Folder – If Debugging is enabled, the debug files are written here. The 
debug file will contain the raw data transmitted from the sender and therefore 
may contain PHI. This data is always encrypted. 
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SECURITY CONSIDERATIONS 
 
Organizations should ensure that the Computer operating system is deployed, 
configured, and managed to meet the security requirements of the organization. As 
part of the planning process here are several recommendations and notes that should 
be factored in: 

• It is recommended that this product be installed on a Computer with only software 
related to this one such as other Datamed® modules and related vendor-provided 
software. 

• The organization is responsible for securing and maintaining the Computer that this 
product is installed on. DLLC does not restrict the antivirus products that can be used, 
nor are they validated. Likewise, OS patches are not restricted or validated.  
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CHAPTER 1 – GETTING STARTED 
 

he DatamedSnd™ Model DSND01 Transmitter Module (“DSND01”) is a utility that monitors a 
folder for files with a specific extension (.dcm), reads the file into memory, and then transmits 
the data to a server using a DICOM® C-STORE transaction. It is used with the DatamedFT™ EKG 

Format Translator which writes out the .dcm files to be transmitted. The program runs as a system 
service and will monitor the configured folder for incoming files. Note that an organization using 
DatamedWL™ will not use this program because the DICOM® transmission functionality is already built 
into DWL. 

All Datamed® Software is user-installed on a Computer provided by and maintained by the organization. 
DLLC does not require any direct access to the Computer. The organization is responsible for providing 
a technical resource with access to the Computer that will work with DLLC for the installation, 
configuration, updates, and any technical support. Under no circumstances will DLLC accept any 
unmonitored access such as VPN to the organization’s network or to the Computer.  

 

 

IMPORTANT NOTE: Support must be maintained for continued operation of the software. As 
specified in the EULA, the license will expire 2 years after support expires. If it is allowed to 
expire then a License Reactivation Fee must be paid along with the support renewal to re-enable 
the software. 

 

  

T 
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Definitions, Acronyms and Abbreviations 

DSND01 DatamedSnd™ DSND01 

DFT DatamedFT™ Format Translator 

DLLC Datamed LLC 

DWL DatamedWL™ 

 

SL Software License Key 

HL Hardware License Key 

 

ACC Sentinel Admin Control Center (web page) 

Computer A physical or virtual machine running a supported version of a Windows® 
operating system where the DLLC software is installed 

Configurator DSND01 Configurator (on the desktop) 

Start Menu Windows® Start Menu 

 

Start Menu Shortcuts (for files in the install folder) 

Install License Key Drivers Shortcut to HASPUserSetup.exe 

Sentinel License Utility Shortcut to DatamedSentinelUtility.exe 
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CHAPTER 2 – INSTALLATION 

Requirements 
 License Key.  The licenses that are required for the applications to run are contained 

in a License Key which can be either software or hardware. 

o A Software License Key is activated on a specific computer and locked to that 
computer. This is normally used for VMs.  

o A Hardware License Key is a specialized USB device (dongle) that must be 
accessible to the application at all times. This is normally used for a physical 
computer but it can be used with a VM by assigning it to the VM in the VM host 
configuration, or it can be plugged into a USB-to-Ethernet adapter and 
connected with a special driver. It should be green or black and look like one of 
these: 

   
When the key needs to be updated (for license additions and support renewals), it is 
updated via email – see Updating the License Key later in this chapter for instructions. 
NOTE: The HASP driver must be v9.12 or higher. 

 Software. The installation package from DLLC which will be supplied via download link.  

 Computer. This software is independent of the destination system and can be installed 
either on the destination system server (if permitted by the manufacturer) or anywhere 
with network access to the destination system. It should be installed on the same 
computer as DatamedFT™. The minimum specifications for the computer at the time 
of this printing are: 4GB RAM, 40GB HD, and a LAN connection. The following operating 
systems are supported: Windows® Server 2016, Windows® Server 2019, Windows® Server 
2022, and Windows® Server 2025. The .NET 4.8 Framework (or higher) must be installed 
on this computer. Check the DLLC website for the latest changes to the system 
requirements. 

 LAN considerations. The DSND01 software transmits via a TCP/IP connection on a 
configured port. The folder that is being monitored must be a local folder. If Windows 
Firewall is turned on, make sure any required rules are added to allow the traffic 
to pass. 

  



DSND01 Service Manual  

 

10 Chapter 2 – Installation | Datamed LLC 

 

New Software Installation 
These instructions are for a new installation where there is no prior version of DSND01 
installed. This can also be used if DSND01 was uninstalled. The Configurator will need to be 
run after installation to configure the settings. 

NOTE: DSND01 v1.x cannot be directly upgraded to v3.x. To upgrade from v1 to v3 
follow the Updating instructions later in this chapter. 

 

Step 1: Install the DSND01 software 

 The installer will be delivered as a download link. After downloading, double click 
on DatamedSnd_DSND01_Setup_v3.x.x.exe.  The following screen should appear. 
Select the appropriate language and then click Next to continue. 

 

 

 The introduction screen will appear.  Click Next to continue. 
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 Read the License Agreement carefully. IMPORTANT: THIS EULA IS A BINDING 
CONTRACT BETWEEN THE ORGANIZATION (END USER) AND DATAMED LLC FOR 
THE USE OF THE SOFTWARE. THE TECHNICIAN INSTALLING THE SOFTWARE 
MUST HAVE THE AUTHORITY TO ACCEPT A CLICK-THROUGH CONTRACT ON 
BEHALF OF THE ORGANIZATION. Once you confirm this authority and review the 
license, select I accept the terms in the license agreement and then click Next to 
continue. 

 

 

 Select the installation folder for the program (normally the default location) and 
then click Next to continue. 
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 When ready, click Next to begin the installation. Installation should take no more 
than 1-2 minutes. 

 

 

 Once installation is complete, this screen will appear. If you want to run the 
configuration utility (Configurator) immediately, check the Launch DatamedSnd 
DSND01 box. Note that you can’t start the software until the license is activated. 
Click Finish to close the window. 
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Step 2: Install the License Key Driver 

 The license key driver and the Software License Key (if applicable) will only be 
installed and activated once on the Computer, regardless of how many Datamed 
suite applications are installed. If the license has already been activated with a 
previous module such as DFT then skip to the next step. 

 To install the license key driver, open the Start Menu and locate DatamedSnd 
DSND01  Install License Key Drivers. Run this to install the full driver package. 
The driver includes a web-based interface called the Sentinel Admin Control Center 
(ACC) with tabs on the left side that allows a user to view the license key(s) and 
the license entitlements (products and features), apply license updates, and gather 
diagnostics. It will show license keys that are installed on the local Computer and 
also any other servers in the same subnet. To access the ACC (a) select Sentinel 
Admin Control Center from the Start Menu, (b) open a browser to 
http://localhost:1947, or (c) choose Open Sentinel Admin Control Center from the 
Tools menu in the Configurator. 

 Here are some useful direct URLs for the ACC screens: 

a. Sentinel Keys: http://localhost:1947/_int_/devices.html 

b. Update/Attach: http://localhost:1947/_int_/checkin.html 

c. Diagnostics: http://localhost:1947/_int_/diag.html  

 

  

http://localhost:1947/
http://localhost:1947/_int_/devices.html
http://localhost:1947/_int_/checkin.html
http://localhost:1947/_int_/diag.html
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Step 3 Option 1: Activate a Software License Key 

 This is a two-step procedure that requires coordination with DLLC and only takes a 
few minutes. The first step is to collect the license fingerprint and send it to DLLC, 
and the second step is to apply the activation file that we send back. It can be 
done using the web interface (ACC) or using a standalone utility. To use the ACC: 

a. Open the ACC and go to Sentinel Keys. If the driver and DLLC library were 
installed properly then there will be a line with Location “Local”, Vendor 
“11974”, Key Type “Reserved for New SL Key”, and Configuration “SL”. 
Click the Fingerprint button to the right to generate a fingerprint file 
(.c2v). This will be written to the default download folder. Send that to 
support@datamed.com for activation. 

 

b. When you receive the activation file (.v2c), open the ACC again and select 
Update/Attach on the left-side menu. Use Select File to browse to the 
activation file and then click Apply File. Notify DLLC support if there is an 
error message instead of a success message. 

 

  

mailto:support@datamed.com
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 To use the standalone Sentinel License Utility: 

a. Open Sentinel License Utility from the Start Menu or from the Tools menu 
in the Configurator. On the Collect Status Information tab select 
Installation of new protection key and then press Collect Information to 
generate a fingerprint file (.c2v). Send that to support@datamed.com for 
activation. 

 

b. When you receive the activation file (.v2c), open the Sentinel License 
Utility again. On the Apply License File tab press the button with 3 dots at 
the bottom to browse to the activation file and select it, then click Apply 
Update. Notify DLLC support if there is an error message instead of a 
success message. 

 

 

mailto:support@datamed.com
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 Check to confirm that the license is activated and accessible. Open the ACC and go 
to Sentinel Keys. If the driver and DLLC library were installed properly then there 
will be a line with Location “Local”, Vendor “11974”, and Key Type “HOST SL 
AdminMode”. The Key ID is specific to this Computer and should be checked for a 
match with the filename when applying an update. A Serial Number has also been 
assigned but is not visible in the ACC, only in the Configurator. 

 

Step 3 Option 2: Install a Hardware License Key 

 For a Hardware License Key, insert the hardware key into the USB port and confirm 
that the LED inside the key lights. If you are using a USB-to-Ethernet adapter follow 
the instructions that came with the adapter and install the driver, then configure it 
to point to the adapter and USB port. 

 Check to make sure that the License Key is available. Open the ACC and confirm 
that you see the License Key in the list with Location “Local” and Vendor “11974”. 

 

Step 4: Configure the software 

 Start the Configurator and enter the desired settings. See Chapter 3 for details. 

 

Updating the Software 
If DSND01 v3.2 or higher is already installed, running the setup program will update it. The 
screens are the same as a new installation.  

If DSND01 v3.0 or v3.1 is already installed, the old shortcuts in the Datamed folder on the 
Start Menu must be manually removed before installing v3.2. It is normally here: 
C:\ProgramData\Microsoft\Windows\Start Menu\Programs. Locate “Datamed” in this folder 
and delete it. Then run the setup program normally to update in place.  

If DSND01 v1.x is installed, follow these steps: 
• Stop the DatamedSnd_DSND01 and DatamedSnd_DSND01Start services. 
• Open the Configurator and copy all the settings down manually. 
• Uninstall the old version. Reboot the server if prompted to do so. 
• Follow the instructions above for a new installation, including installing the latest 

license key driver. A license update will be supplied if there is already a Software 
License Key installed. 

• Start the Configurator and configure it with the settings you wrote down. 

 



 DSND01 Service Manual 

 

Datamed LLC | Chapter 2 – Installation 17 

 

Uninstalling the Software 
To uninstall DSND01, do one of the following: 1) from the Start Menu locate DatamedSnd 
DSND01 → Uninstall DSND01 and select it; or 2) open Control Panel, choose Add or Remove 
Programs, select DatamedSnd_DSND01, and press the Remove button. In either case the 
application will be removed. It may take a minute or two for the uninstall to complete. 
Note that only the application is removed – all ECG files and logs will remain as well as the 
License Key Driver. 

 

Updating the License Key 
When support is renewed or licenses are added, the License Key must be updated. DLLC 
will email a license update file (.v2c) which needs to be applied. This can be done using 
the web interface (ACC) or using the standalone Sentinel License Utility.  

Applying an update using the ACC 

 Open the ACC and select Update/Attach on the left-side menu (the direct URL is 
http://localhost:1947/_int_/checkin.html). Use Select File to browse to the 
activation file and then click Apply File. Notify DLLC support if there is an error 
message instead of a success message. 

 

  

http://localhost:1947/_int_/checkin.html
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Applying an update using the Sentinel License Utility 

 Open the Sentinel License Utility from the Start Menu or from the Tools menu in 
the Configurator. On the Apply License File tab press the button with 3 dots at the 
bottom to browse to the activation file and select it, then click Apply Update. 
There should be a success message, otherwise let us know if there is an error. 

 

 Check to confirm that the license is activated and accessible. Open the ACC and go 
to Sentinel Keys. If the driver and DLLC library were installed properly then there 
will be a line with Location “Local”, Vendor “11974”, and Key Type “HOST SL 
AdminMode”. The Key ID is specific to this Computer and should be checked for a 
match with the filename when applying an update. 

In some cases DLLC will need to collect a new fingerprint file from the Computer for a 
Software License Key. This can happen when there is a change to the computer that affects 
the “internal fingerprint” used by the license software. Collecting this fingerprint file 
(.c2v) can be done using the web interface (ACC) or using the standalone 
DatamedSentinelUtility. Once the file is collected it should be sent to DLLC. 

 Open the ACC and select Sentinel Keys on the left-side menu. On the line with 
Location “Local”, Vendor “11974”, and Key Type “HOST SL AdminMode”, press the 
C2V button on the right side to generate the file. 

 Open the Sentinel License Utility. On the Collect Status Information tab select 
Update of existing protection key and then press Collect Information to generate 
the file. 
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Post-Installation Notes 
If this was an update the configuration settings will already be set up and should not need 
to be changed. For a new installation the configuration settings will need to be set up. 
Configuration settings are changed by using the Configurator utility. A shortcut to this 
utility will be found on the desktop, and it can also be found on the Start Menu under 
DatamedSnd DSND01 → DSND01 Configurator. See Chapter 3 for a complete description of 
the configuration settings. 

We recommend setting the service Startup Type to Automatic (Delayed Start). After 
installation open the Services applet, locate the DatamedSnd_DSND01 service, right-click 
on Properties, and change Startup Type to Automatic (Delayed Start). An alternate 
method is to run this from the command line (note that the space after the ‘=’ is required): 

sc config DatamedSnd_DSND01 start= delayed-auto  

Note that the DatamedSnd_DSND01 service will not start automatically until the computer 
is rebooted. It can also be started interactively using the Configurator utility. An 
alternative method of starting the service is to open the Services applet from Control 
Panel → Administrative Tools and start DatamedSnd_DSND01. 

IMPORTANT NOTE: This application should always be installed on the same 
Computer as DatamedFT™.  

Once the setup and the configuration is complete, the connection to the destination server 
should be tested. This is done using the Test Connection button in the Configurator. 
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CHAPTER 3 – CONFIGURING DSND01 
 

nce DSND01 is installed, changes to the configuration settings can be done using the 
Configurator utility that is installed along with the service. Open the utility from the desktop 
shortcut or from the Start Menu and it will automatically read the current configuration 

settings from the registry. When configuration changes are made, they must be saved and then the 
service must be restarted for them to take effect. 

 

 

 

Window Settings 
The main section of the window has several items: 

 Input folder. This is the folder that will be monitored for incoming files. This must be 
the Output folder for DFT and will always be a local folder. The application will be 
monitoring this folder for files with an extension of .dcm. The Browse button allows 
you to browse for the folder to use (or create one). This will be yellow if the folder 
does not exist.  

 Local AE Title. This is the AE Title for DSND01 when acting as an SCU (Service Class 
User) making the C-STORE request. 

 Remote AE Title. This is the AE Title of the DICOM SCP (Service Class Provider) that 
will accept and service the C-STORE request. 

 Remote IP Address and Port. This is the host name or IP address and the port for the 
DICOM SCP that will accept and service the C-STORE request. 

 Test Connection. When this button is pressed it will generate a DICOM ECHO 
transmission to confirm that the destination server is available and listening. 

O 
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 Transfer Syntax. This is used to specify what Transfer Syntax will be used in the 
transmission: “Explicit VR Little Endian” (default) or “Implicit VR Little Endian”.  

At the bottom of the window there is a status indicator and four buttons: 

 Service Status. This shows the current status of the DatamedSnd_DSND01 service. 
There are several possible values: Stopped – indicates that the service is not running; 
Running – indicates that the service is running; Starting – which indicates that the 
service is in the process of starting; Stopping – which indicates that the service is 
shutting down; Paused – which indicates that the service was manually paused; and 
Unknown – which indicates a problem. The blue statuses are normally transitional so if 
the status remains for more than a couple of seconds then there is a problem. The 
most common reason for this condition is that the License Key is not present or 
accessible. 

 Start. This button will start the DatamedSnd_DSND01 service. 

 Stop. This button will stop the DatamedSnd_DSND01 service. 

 Save Changes. This button will cause all configuration changes to be saved to the 
registry. Previous settings will be discarded. 

 Close. This button closes the window. Any unsaved changes will be discarded. 

 

Menu Options 
The following menu options are available:  

 File  Reload from registry. Selecting this will cause any changes to be discarded and 
the settings on the screen reset to the saved values. 

 File  Save to registry. This is the same as clicking the Save Changes button. 

 File  Import settings from file. This will load configuration settings from a DSND01 
Settings (.ds1) file. This file is created by exporting the settings. Note that the settings 
are loaded into the window but are not saved to the registry until the Save Changes 
button is clicked. 

 File  Export settings to file. This will save the configuration settings as they exist in 
the window (possibly edited) to a DSND01 Settings (.ds1) file. This file should not be 
edited manually. Typically this functionality is used to send the configuration settings 
to DLLC for troubleshooting. 

 File  Enable Debugging. This should only be enabled if there is a problem with the 
application and DLLC support personnel request it. After turning on this option and 
restarting the service, files containing debugging information will be written to the 
Output Folder. This information should be sent to DLLC support for analysis and the 
option should be disabled. 
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 File  Enable Low-Level Debugging. This option is only available after Enable 
Debugging is turned on. In rare cases DLLC support personnel may need to collect 
granular debugging data to diagnose a transmission issue. After turning on this option 
and restarting the service, the debug files will grow quickly so only leave it on long 
enough to capture the transaction requested by DLLC. 

 File  Exit. This is the same as clicking the Close button. 

 Tools  Open Windows Event Viewer. This will open the Event Viewer to the 
Application Event Log.  

 Tools  Open Windows Services Manager. This will open the services applet so that 
you can access the properties for Windows services.  

 Tools  Open Sentinel Admin Control Center. This will open the ACC web page using 
the default browser.  

 Tools  Open Sentinel License Utility. This will run the DatamedSentinelUtility.exe 
utility in the installation folder.  

 Help  About. This will open a window that displays information about the application 
and the license details.  

 Help  Open Datamed Website. This will open datamed.com using the default 
browser.  

 

http://datamed.com/
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CHAPTER 4 – SYSTEM CONFIGURATION 
 

he system that receives the transmission from DSND01 must be configured properly so that it 
will accept the transmission. The Remote AE Title, IP Address, and Port are all critical for the 
transmission to reach the intended destination. The Local AE Title is also very important 

because many systems use this value to limit or route the incoming data. Always consult the system 
documentation and the manufacturer’s instructions. 

 

 

 

 

T 
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CHAPTER 5 – TROUBLESHOOTING 
 

hen DSND01 is installed, a new Windows™ service named DatamedSnd_DSND01 is created. 
The service continually monitors the License Key and if it is removed the service will log a 
message to the Event Log and stop processing. Once the key is connected again the service 

will resume processing. Note that if the License Key is not connected then the service will not start. 
The Configurator utility can be used to start, stop, and monitor the service. 

The Sentinel LDK License Manager service was installed by the license key driver, and it must be 
running at all times. If the service is reporting that the license key is not present, it might be due to 
this service being stopped or unresponsive. This can generally be resolved by restarting the service or 
restarting the Computer. Then check the ACC web page to confirm that the license is available. If the 
license key needs to be updated, review the steps in the Updating the License Key section of Chapter 
2. 

If there is a problem, the first place to look is the Event Viewer, which can be accessed from Control 
Panel → Administrative Tools or from the Tools menu. Once the viewer is opened, select Application 
from the left side menu and the right side will be filled with the application event log. Double-clicking 
on any entry in the log will open a window that shows the details for the event. The Type column in 
the log will indicate whether this is an Information or Error message, and the Source column will 
indicate what service logged the entry. The Information messages are normal and for a normal startup 
there will be two or more from DatamedSnd_DSND01 depending on the configuration. The Error 
messages describe problems that have occurred. Reviewing the log entries will give insight into what is 
working and what is a problem. If the License Key could not be contacted, the service will log an Error 
message describing the condition.  

After the startup message, there should be an event log message that gives the IP address and port 
that the listener is monitoring and the directory where files will be written. If a message that should be 
there is not present, check the configuration settings using the Configurator to confirm that the 
parameters are correct (see Chapter 3 for details). In most cases there will be an error message that 
describes the problem. Most errors are self-explanatory and can be resolved by correcting the setting 
or condition that caused them. 

Here are some other common issues and answers: 

• Symptom: The License Key cannot be located or is marked as Cloned 

o The License Key is required for the DatamedSnd_DSND01 service to run. Whether the 
License Key is attached to the computer directly, attached to the VM’s host computer, 
or connected by network, it must be accessible and a local driver must be installed. To 
verify that the key is connected, do one (or both) of the following: 

 Start the Configuration Utility and select Help → About on the menu. After a 
moment it should show the license information. 

W 
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 Open the ACC from the Start Menu, the Tools menu in the Configurator, or 
manually opening http://localhost:1947 from a browser. Confirm that there is 
a line with Location “Local”, Vendor “11974”, Key Type “HOST SL 
AdminMode”, and a value for Key ID. 

o For a Hardware License Key there is a light on the physical key that should be on if the 
driver is working. 

o If the Security Key still can’t be located or is marked as Cloned in the ACC, contact 
DLLC support. 

• Symptom: The system does not receive the record 

o If the service starts properly but no files are received by the system when DSND01 
makes a transmission, then the communication needs to be checked. The most common 
reason is that the IP address and port setting does not match the destination system. 
Recheck both settings to ensure they match and use the Test Connection button. 

o Another common problem is that there is a firewall interfering with the outgoing 
transmission. Ensure that the configured port is open. 

o DLLC support personnel may need to gather detailed information using the debugging 
facility. If directed to collect debugging information, follow the directions to enable 
debugging in Chapter 3. The debug file(s) will be created in the output folder and 
should be sent to DLLC.  

• Symptom: The file is renamed to .TransmitError 

o This means there is a problem transmitting the file and it usually points to a problem 
with the configuration settings, a firewall or network issue, or a problem with the 
destination server. Once the issue with the network or server is resolved, rename the 
file to .dcm to reprocess it. 

• Symptom: The file is renamed to .CorruptFile 

o This means that the file is not a valid DICOM file or has been corrupted in some way. 
Resend the record if needed. 

• Symptom: The file is renamed to .ZeroLengthFile 

o This means that the file is completely empty.  

 

DLLC support can be reached by email at support@datamed.com or by phone at 
either (800) 601-3361 ext 2 (within the US) or +1 901 672 6225 ext 2 (outside the 
US).  

http://localhost:1947/
mailto:support@datamed.com
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APPENDIX A – REGISTRY SETTINGS 
 

If it is necessary to change the settings for DSND01 after installation, the Configurator utility should be 
used. There is normally no reason to access the registry editor to make the changes. If DLLC support 
personnel request it, you can open the registry editor by selecting Start → Run and then type 
“regedit” and press OK. When the registry editor opens, navigate the folders to 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\DatamedSnd_DSND01.  

Most of the settings must not be changed or the operation of DSND01 will be affected. If any setting is 
changed DatamedSnd_DSND01 must be restarted. 
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APPENDIX B – END USER LICENSE AGREEMENT 
 
The current End User License Agreement (EULA) can be found on DLLC’s web site here: 
datamed_eula.pdf. The following EULA was current at the time of this printing but is subject to being 
replaced by a more current version that is found on the website. 

 

End-User License Agreement for Datamed® Software 
 

IMPORTANT—READ CAREFULLY: This End-User License Agreement ("EULA") is a legal agreement between Datamed 
LLC (“Datamed”) and the End User.  Both you and the entity you act on behalf of in your capacity as an employee of such 
entity, or as an agent, contractor or representative of such entity shall be considered the End User for purposes of this EULA 
(collectively and individually, “you”). This EULA applies to the Datamed® software that accompanies this EULA, which may 
include associated media and printed and/or electronic documentation (individually and collectively, the "Product"). An 
amendment or addendum to this EULA may accompany the Product. No other person or entity personally or in any other 
capacity may acquire rights to use the Product pursuant to this EULA. YOU AGREE TO BE BOUND BY THE TERMS OF 
THIS EULA BY AGREEING TO ACCEPT THE TERMS AND CONDITIONS OF THIS EULA, AND/OR BY INSTALLING, 
COPYING, OR USING THE PRODUCT.  IF YOU ARE NOT WILLING TO ACCEPT THE TERMS AND CONDITIONS OF 
THIS EULA, THEN DECLINE TO ACCEPT AND REFRAIN FROM INSTALLING, COPYING OR USING THE PRODUCT.  

IN ADDITION TO THE TERMS SET FORTH HEREIN, YOU ALSO AGREE TO BE BOUND BY THE TERMS AND 
CONDITIONS FOR THE PURCHASE, SHIPPING AND DELIVERY OF DATAMED PRODUCTS THAT ARE POSTED ON 
DATAMED’S WEBSITE (WHICH CAN BE VIEWED AND/OR DOWNLOADED AT 
HTTPS://DATAMED.COM/DOCS/DATAMED_TERMS_CONDITIONS.PDF). 

1. LICENSE AND USE.   

1.1 Grant of License.  In consideration for, and subject to, your agreement to the terms and conditions of this EULA, 
Datamed hereby grants to you a limited, non-exclusive, non-transferable, non-sublicensable license to use, and allow 
your employees and representatives, solely in their capacity as employees and representatives and for no other 
purposes (“Authorized Users”), to use the Product, in object code form only, for your own internal business purposes 
and subject to the terms and conditions contained herein.  The Product can be licensed as (i) a fully-paid license or (ii) 
a subscription license that needs to be renewed periodically with the payment of additional subscription fees. A fully-
paid license is not a perpetual license and it gives you a right to use the licensed version of the Product continuously 
until terminated by the terms and conditions set forth in this EULA. A subscription license gives you a right to use the 
Product for the time period set forth in the applicable invoiced order, or if no period is specified, for a time period of 
twelve (12) months from the date of installation. If a subscription license expires and is not renewed, you no longer 
have any further right to use the Product.  If the relevant and applicable documentation does not specify which type of 
license you have, then your license shall be a subscription license. 

https://datamed.com/docs/datamed_eula.pdf
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1.2  Installation and Use for Protected Products. For each Product purchased, you may install and use a single 
instance of the Product on a single computer (physical or virtual). The Product is protected by either a Hardware 
License Key or a Software License Key to prevent the operation of the Product on more than one computer.  By 
installing the Product you expressly agree to (a) the installation of the appropriate drivers for the Hardware or Software 
protection mechanism, and (b) not alter, modify or otherwise interfere with such protection systems, and (c) not 
attempt (or allow any other entity to attempt) to circumvent the protection or run the Product on more than one 
computer.  You may transfer the Product between computers provided that it is used on only one computer owned and 
controlled by you at any given time for each Product purchased.  You acknowledge and agree that any Hardware 
License Key or Software License Key that is lost or destroyed will not be replaced without additional charge. 

1.3. Additional Servers.  You need a Hardware License Key or Software License Key for each computer that a 
Product is installed on and used in an operating environment.  Datamed offers an Additional Software License (“ASL”) 
for a fee that comes in a Hardware License Key or a Software License Key and contains a duplicate of the production 
server license. An ASL can be used for testing, hot backup, or disaster recovery but cannot be used as a production 
server. You may install an inactive copy of a Product on an additional computer, as long as the Product is not used in 
an operating environment, unless and until you acquire another Hardware License Key or Software License Key or 
transfer a Hardware License Key or Software License Key in compliance with Section 1.2. 

1.4 Connection Licenses. Certain Products (DatamedFT™ and DatamedWL™) consist of a license for a specific 
destination system connection (the “Base Software License”) and one or more licenses for a specific source device 
connection (“Connection Licenses”). For these Products you must acquire the appropriate number and type of 
Connection License for each originating source device that accesses your instance of the Product directly or indirectly, 
and limit the count of such devices to the number of Connection Licenses purchased from Datamed.  Upon request 
from time to time, but not more often than annually, you shall report to Datamed in writing an accurate inventory of all 
such devices, and shall not alter, modify or otherwise interfere with any mechanisms or routines in the Products that 
report device counts to Datamed. For Products that are licensed based on the number of source devices, use of each 
such Product with more devices than Connection Licenses is not allowed under this EULA and is a material breach of 
this EULA.  

1.5 License Grant for Documentation. Any documentation that accompanies the Product is subject to the license set 
forth in Section 1.1 and may only be used for internal, non-commercial reference purposes only. 

1.6 Use of the Product.  You and Your Authorized Users agree to use the Product in compliance with all applicable 
federal, state, and local laws, rules, and regulations.  You are solely responsible for the adequacy and accuracy of all 
data, programs, procedures, and other information that you and/or your Authorized Users input into the Software and 
the results obtained therefrom. You are fully responsible for making all treatment decisions and providing medical care 
with respect to all patients whose data may be processed using the Product. Your use of the Product does not 
constitute the rendering of medical care or advice by Datamed, Datamed and its staff are not medical providers and 
are not intended to replace the relationship between patients and their healthcare provider(s). 

1.7 Lifetime of the License. Unless the term of any license subject to this EULA is determined pursuant to another 
written license agreement between you and Datamed, (a) the subscription license is limited by the subscription period, 
and (b) the fully-paid license is time-limited and will terminate on the second anniversary of the expiration of your 
support plan. As long as Datamed offers support plans for the Product, you may (a)  renew your support plan prior to 
the second anniversary of the expiration of your previous support plan, or (b) restore your license by both paying a 
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reactivation fee (as identified on the then current published Price List), and renewing your support plan, either (a) or 
(b) result in extending the license for the duration of the current support plan and two years beyond. 

1.8 Releases and Sunset of Product Versions. THE LATEST VERSIONS OF RELEASES OF ALL PRODUCTS 
ARE IDENTIFIED ON DATAMED’S WEBSITE (http://www.datamed.com).  YOU ARE RESPONSIBLE FOR 
CHECKING TO SEE WHEN NEW RELEASES ARE AVAILABLE.  Patch Releases (identified in Product version 
X.Y.Z by a change to the “Z” field) and Standard Releases (identified in Product version X.Y.Z by a change to the “Y” 
field) (individually, a “Release” and “collectively” Releases”), are created at Datamed's discretion and are available at 
no cost (a) to subscription licensees, and (b) to fully-paid licensees as long as a support plan for the associated 
Product is in force. In the event that a Release is a result of a mandatory regulatory change or to correct or mitigate an 
infringement claim, you will be notified and to the extent such Release is made available to you, you are required to 
update the Product to the new Release. If you fail to install such Release within the period prescribed by Datamed, 
you shall be solely responsible for, and Datamed shall have no liability regarding, any liability or damages incurred by 
you in connection with or arising from your failure to install such Release.  All Releases sunset no later than twenty-
four (24) months after being replaced by new release and Datamed is under no obligation to support any version after 
it is sunset. 

1.9 Sunset of Product. Notwithstanding the foregoing, Datamed reserves the right to sunset any Product without 
notice. 

2. RESERVATION OF RIGHTS AND OWNERSHIP. Datamed reserves all rights not expressly granted to you in this EULA. 
The Product is protected by copyright and other intellectual property laws and treaties. Datamed or its Representatives own 
the title, copyright, and other intellectual property rights in the Product and any copies thereof or derivative works thereto. 
The Product is licensed, not sold. This EULA does not grant you any rights to trademarks or service marks of Datamed.  
Notwithstanding anything herein to the contrary, you agree to not use or exploit the Product as a source or reference to 
conceive, create, develop or offer any product or service similar in form, function or concept to the Product. 

3. FEEDBACK.  Datamed may provide you with a mechanism to provide feedback, suggestions and ideas, if you choose, 
about its products and services (“Feedback”).  You agree that Datamed may, in its sole discretion, use the Feedback you 
provide to Datamed in any way, including in future modifications of the Product.  You hereby grant Datamed a perpetual, 
worldwide, fully transferable, irrevocable, royalty free license to use, modify, create and own derivative works from, distribute 
and display any information you provide to Datamed in the Feedback.   

4. RESTRICTIONS; LIMITATIONS ON REVERSE ENGINEERING, DECOMPILATION, AND DISASSEMBLY. You are not 
licensed or permitted to do, nor may you permit your Authorized Users to:   

 (i) make additional copies of the Product except as provided herein;  

 (ii) give copies to another person who has not purchased a license for the Product from Datamed;  

 (iv) duplicate the Product by any other means including electronic transmission;   

 (v) reverse engineer, decompile, or disassemble the Product;   

 (vii) without the prior written consent of Datamed, transfer or assign the license and your rights to the Product 
under any circumstances including to an affiliate or any other entity under common ownership with you or under your control 
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or upon a merger, change of control, reorganization, consolidation or sale of all or substantially all of your assets or seek to 
sublicense or assign the license of your rights hereunder;  

 (viii) Distribute, rent, sell, loan, lease, sublicense, or otherwise deal in the Product and or any other component 
elements of the Product; 

 (ix)  use the Product to facilitate or perform bulk translations of any electrocardiogram data or any other data that 
may be processed through the Product; and/or 

 (x)  use the Product on or in connection with an application service provider platform or other hosted website, 
application or platform, or as a software as a service. 

 (xi) disclose or allow the disclosure of Personally Identifiable Information, Personal Healthcare Information and/or 
Personal Data, as may be defined in any applicable law, except as expressed permitted pursuant to applicable law.  
Notwithstanding anything else to the contrary, you will never disclose such Personally Identifiable Information, Personal 
Healthcare Information and/or Personal Data to Datamed unless Datamed provides prior written consent to each such 
disclosure event. 

You agree that in the event of actual or threatened breach of this Section by you, Datamed will have no adequate remedy at 
law and will be entitled to immediate and injunctive and other equitable relief, without bond and without the necessity of 
showing actual money damages. 

5. TERMINATION. Without prejudice to any other rights, Datamed may terminate this EULA immediately and without notice 
if you fail to comply with any term or condition of this Agreement.  Upon such termination your license is terminated 
immediately and you must immediately cease the use of and destroy all complete and partial copies of the Product, 
including all backup copies.  Sections 4, 8, 9, 10, 11, 13, 14 and this Section 5 shall survive any expiration or termination of 
this EULA. 

6. LIMITED WARRANTY FOR PRODUCT. Datamed warrants that the Product will perform substantially in accordance with 
the documentation thereof for a period of ninety (90) days from the date of receipt. If support is not provided through the 
party that distributed the Product to you, extended support and maintenance may be available for purchase from Datamed 
and shall be subject to such terms and conditions as Datamed may from time to time provide in a separate document or a 
support and maintenance plan; provided that Datamed’s obligations related to the warranty provided herein or such 
additional support shall be expressly subject to your continued compliance with the terms and conditions of this EULA and 
the timely payment of any and all amounts owed to Datamed and its affiliates.  THE SOLE REMEDY FOR ANY CLAIMS 
UNDER THIS WARRANTY IS REPAIR OR REPLACEMENT OF THE PRODUCT, AS DATAMED’S OPTION. 

If an implied warranty or condition is created by your state/jurisdiction and federal or state/provincial law prohibits 
disclaimer of it, you also have an implied warranty or condition, BUT ONLY AS TO DEFECTS DISCOVERED DURING 
THE PERIOD OF THIS LIMITED WARRANTY (NINETY DAYS). AS TO ANY DEFECTS DISCOVERED AFTER THE 
NINETY DAY PERIOD, THERE IS NO WARRANTY OR CONDITION OF ANY KIND. Some states/jurisdictions do not allow 
limitations on how long an implied warranty or condition lasts, so the above limitation may not apply to you. 

Any supplements or updates to the Product, including without limitation, any updates provided to you after the expiration of 
the ninety day Limited Warranty period are not covered by any warranty or condition, express, implied or statutory. 
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7. YOUR EXCLUSIVE REMEDY. Datamed’s entire liability and your exclusive remedy for any breach of this Limited 
Warranty or for any other breach of this EULA or for any other liability relating to the Product shall be, at Datamed’s option 
from time to time exercised subject to applicable law, (a) return of the amount paid (if any) for the Product, or (b) repair or 
replacement of the Product that does not meet this Limited Warranty and that is returned to Datamed. You will receive the 
remedy elected by Datamed without charge, except that you are responsible for any expenses you may incur. This Limited 
Warranty is void if failure of the Product has resulted from accident, abuse, misapplication, abnormal use a virus, or violation 
of any terms in this EULA. Any replacement Product will be warranted for the remainder of the original warranty period or 
thirty (30) days, whichever is longer, and Datamed will use commercially reasonable efforts to provide your remedy within a 
commercially reasonable time of your compliance with Datamed’s warranty remedy procedures. Datamed may use 
electronic means to deliver the product. To exercise your remedy, contact: Datamed by email at support@datamed.com. 

8. DISCLAIMER OF WARRANTIES. The Limited Warranty above is the only warranty made to you and is provided in lieu of 
any other warranties or similar obligations (if any) created by any advertising, documentation, packaging, or other 
communications. No employee, agent, representative or affiliate of Datamed has authority to bind Datamed to any oral 
representations or warranty concerning the Product. Any written representation or warranty not expressly contained in this 
EULA will not be enforceable. EXCEPT FOR THE LIMITED WARRANTY, THE PRODUCT, SOFTWARE, RELATED 
MATERIALS, DOCUMENTATION AND/OR ANY SERVICES RELATED TO THE PRODUCT, ARE PROVIDED "AS-IS, 
WITH ALL FAULTS," AND TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, DATAMED AND ITS 
SUBSIDIARIES, AFFILIATES, LICENSORS, DISTRIBUTORS, DEALERS OR SUPPLIERS ("REPRESENTATIVES") 
DISCLAIM ALL OTHER REPRESENTATIONS AND WARRANTIES, EXPRESS OR IMPLIED, REGARDING THE  
PRODUCT, SOFTWARE, RELATED MATERIALS, CONTENT AND ANY SERVICES, INCLUDING FITNESS FOR A 
PARTICULAR PURPOSE, SECURITY, QUALITY, MERCHANTABILITY, AND THEIR NON-INFRINGEMENT. DATAMED 
EXPRESSLY DISCLAIMS ANY REPRESENTATIONS OR WARRANTIES THAT YOUR USE OF THE PRODUCT WILL 
SATISFY ANY STATUTORY OR REGULATORY OBLIGATIONS, OR WILL ASSIST WITH, GUARANTEE OR 
OTHERWISE ENSURE COMPLIANCE WITH ANY APPLICABLE LAWS OR REGULATIONS, INCLUDING BUT NOT 
LIMITED TO THE HEALTH INSURANCE PORTABILITY AND ACCOUNTABILITY ACT OF 1996 (“HIPAA”) OR OTHER 
FEDERAL OR STATE STATUTES OR REGULATIONS.  YOU ARE SOLELY RESPONSIBLE FOR ENSURING THAT 
YOUR USE OF THE PRODUCT, RELATED SERVICES OR CONTENT IS IN ACCORDANCE WITH APPLICABLE LAW, 
INCLUDING WITHOUT LIMITATION THE HEALTH INSURANCE PORTABILITY AND ACCOUNTABILITY ACT AND EU’S 
GENERAL DATA PROTECTION REGULATION.  IT IS YOUR RESPONSIBILITY TO KEEP ABREAST OF CHANGES IN 
LAWS, REGULATIONS AND HEALTHCARE PRACTICES THAT AFFECT YOU AND YOUR BUSINESS. You shall 
indemnify and hold Datamed harmless from and against any costs, losses, liabilities and expenses (including reasonable 
attorneys’ fees) arising out of any claims related to your use of the Product or violation of this EULA. 

9. EXCLUSION OF INCIDENTAL, CONSEQUENTIAL AND CERTAIN OTHER DAMAGES. TO THE MAXIMUM EXTENT 
PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL DATAMED OR ITS OFFICERS, EMPLOYEES, AGENTS OR 
REPRESENTATIVES BE LIABLE FOR ANY SPECIAL, INCIDENTAL, PUNITIVE, EXPECTATION, INDIRECT, OR 
CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR LOSS OF 
PROFITS, LOSS OF DATA OR CONFIDENTIAL OR OTHER INFORMATION, FOR BUSINESS INTERRUPTION, FOR 
PERSONAL INJURY, FOR LOSS OF PRIVACY, FOR FAILURE TO MEET ANY DUTY INCLUDING OF GOOD FAITH OR 
OF REASONABLE CARE, FOR NEGLIGENCE, AND FOR ANY OTHER PECUNIARY OR OTHER LOSS 
WHATSOEVER) ARISING OUT OF OR IN ANY WAY RELATED TO THE USE OF OR INABILITY TO USE THE 
PRODUCT, THE PROVISION OF OR FAILURE TO PROVIDE SUPPORT OR OTHER SERVICES, INFORMATION, 
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SOFTWARE, AND RELATED CONTENT THROUGH THE PRODUCT OR OTHERWISE ARISING OUT OF THE USE OF 
THE PRODUCT, OR OTHERWISE UNDER OR IN CONNECTION WITH ANY PROVISION OF THIS EULA, EVEN IN THE 
EVENT OF THE FAULT, TORT (INCLUDING NEGLIGENCE), MISREPRESENTATION, STRICT LIABILITY, BREACH OF 
CONTRACT OR BREACH OF WARRANTY OF DATAMED OR ANY REPRESENTATIVE, AND EVEN IF DATAMED OR 
ANY REPRESENTATIVE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

10. LIMITATION OF LIABILITY AND REMEDIES. NOTWITHSTANDING ANY DAMAGES THAT YOU MIGHT INCUR FOR 
ANY REASON WHATSOEVER (INCLUDING, WITHOUT LIMITATION, ALL DAMAGES REFERENCED HEREIN AND 
ALL DIRECT OR GENERAL DAMAGES IN CONTRACT OR ANYTHING ELSE), THE ENTIRE LIABILITY OF DATAMED 
AND ANY OF ITS OFFICERS, EMPLOYEES, AGENTS OR REPRESENTATIVES UNDER ANY PROVISION OF THIS 
EULA AND YOUR EXCLUSIVE REMEDY HEREUNDER (EXCEPT FOR ANY REMEDY OF REPAIR OR REPLACEMENT 
ELECTED BY DATAMED WITH RESPECT TO ANY BREACH OF THE LIMITED WARRANTY) SHALL BE LIMITED TO 
THE LESSER OF (I) THE ACTUAL DAMAGES YOU INCUR IN REASONABLE RELIANCE ON THE PRODUCT OR (II) 
THE LICENSE FEES ACTUALLY PAID BY YOU FOR THE PRODUCT. THE FOREGOING LIMITATIONS, EXCLUSIONS 
AND DISCLAIMERS (INCLUDING WITHOUT LIMITATION SECTIONS 8, 9, 10 AND 11) SHALL APPLY TO THE 
MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, EVEN IF ANY REMEDY FAILS ITS ESSENTIAL PURPOSE. 
THE DISCLAIMERS AND LIMITATIONS ON LIABILITY SET FORTH ABOVE ARE FUNDAMENTAL ELEMENTS OF THE 
BASIS OF THE AGREEMENT BETWEEN DATAMED AND YOU. 

11. Export Restrictions. You acknowledge and agree that the Product is subject to restrictions and controls imposed by the 
Export Administration Act of 1979, as amended, and the Export Administration Regulations thereunder ("the Acts").  You 
agree and certify that neither the Product nor any direct product thereof is being or will be used for any purpose prohibited 
by the Acts.  You further agree and certify that neither the Datamed Product nor any direct product thereof will be exported 
to countries which are currently subject to U.S. trade embargoes or (ii) persons or entities on the U.S. "Denied Persons List", 
"Specially Designated Nationals List" and "Entities List". 

12.  U.S. GOVERNMENT LICENSE RIGHTS. All Product provided to the U.S. Government pursuant to U.S. Government 
solicitations, task orders, purchase orders, or other procurement are provided with the same (neither greater or lesser) 
commercial license rights and restrictions described elsewhere herein, except that, where the contract resulting from any 
such procurement contains the clause at FAR 52.227-19 (Commercial Computer Software License) (DEC 2007), the U.S. 
Government will have the rights set forth in paragraph (b) of that clause.  

13. APPLICABLE LAW. This EULA is governed exclusively by the laws of the State of Tennessee, USA.  The state and 
federal courts located in Davidson County, Tennessee shall have exclusive jurisdiction to adjudicate any dispute arising out 
of or relating to this Agreement. 

14. ENTIRE AGREEMENT; SEVERABILITY. This EULA (including any addendum or amendment to this EULA which is 
included with the Product) is the entire agreement between you and Datamed relating to the Product and the support 
services (if any) and they supersede all prior or contemporaneous oral or written communications, proposals and 
representations with respect to the Product or any other subject matter covered by this EULA.  This EULA sets forth the 
entire liability of Datamed and its representatives and your exclusive remedy with respect to the Product and services and 
their use.  To the extent the terms of any Datamed policies or programs for support services conflict with the terms of this 
EULA, the terms of this EULA shall control. Any waiver of the terms herein by Datamed must be in a writing signed by an 
authorized officer of Datamed and expressly referencing the applicable provisions of this EULA.  If any provision of this 
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EULA is held to be void, invalid, unenforceable or illegal, it shall be enforced to the extent permissible and all other 
provisions shall continue in full force and effect. Headings are included for convenience only, and shall not be considered in 
interpreting this Agreement.  This EULA does not limit any rights that Datamed may have under trade secret, copyright, 
patent or other laws. 

 

The following Datamed GUARANTEE applies to you if you acquired this Product in any country other than the 
United States: 

Statutory rights not affected - The following guarantee is not restricted to any territory and does not affect any statutory rights 
that you may have from your reseller or from Datamed if you acquired the Product directly from Datamed. If you acquired the 
Product or any support services in Australia, New Zealand or Malaysia, please see the "Consumer rights" section below.  

The Guarantee - The Product is designed and offered as one of Datamed’s Datamed® products. You accept that no Product 
is error free and you are strongly advised to back-up your files regularly. Provided that you have a valid license, Datamed 
guarantees that a) for a period of 90 days from the date of receipt of your license to use the Product or the shortest period 
permitted by applicable law it will perform substantially in accordance with any written materials that accompany the Product; 
and b) any support services provided by Datamed shall be substantially as described in applicable written materials provided 
to you by Datamed and Datamed’s support engineers will use reasonable efforts, care and skill to solve any problem issues. 
Acknowledging that Datamed has limited support resources, all support will be done remotely from Datamed’s home 
location. In the event that the Product fails to comply with this guarantee, Datamed will, at its sole option), either (a) repair or 
replace the Product or (b) return the price you paid. This guarantee is void if failure of the Product results from accident, 
abuse, misapplication, or violation of any terms of this EULA. Any replacement Product will be guaranteed for the remainder 
of the original guarantee period or 30 days, whichever period is longer. You agree that the above guarantee is your sole 
guarantee in relation to the Product and any support services.  

Exclusion of All Other Terms - To the maximum extent permitted by applicable law and subject to the guarantee above, 
Datamed disclaims all warranties, conditions and other terms, either express or implied (whether by statute, common law, 
collaterally or otherwise) including but not limited to implied warranties of satisfactory quality and fitness for particular 
purpose with respect to the Product and any written materials that accompany the Product. Any implied warranties that 
cannot be excluded are limited to 90 days or to the shortest period permitted by applicable law, whichever is greater. 

Limitation of Liability - To the maximum extent permitted by applicable law and except as provided in the Datamed 
Guarantee, Datamed and its Representatives shall not be liable for any damages whatsoever (including without limitation, 
damages for loss of business profits, business interruption, loss of business information or other pecuniary loss) arising out 
of the use or inability to use the Product, even if Datamed has been advised of the possibility of such damages. In any case 
Datamed’s entire liability under any provision of this EULA shall be limited to the amount actually paid by you for the 
Product. These limitations do not apply to any liabilities that cannot be excluded or limited by applicable laws.  

Consumer Rights - Consumers in Australia, New Zealand or Malaysia may have the benefit of certain rights and remedies 
by reason of the Trade Practices Act and similar state and territory laws in Australia, the Consumer Guarantees Act in New 
Zealand and the Consumer Protection Act in Malaysia in respect of which liability cannot lawfully be modified or excluded. If 
you acquired the Product in New Zealand for the purposes of a business, you confirm that the Consumer Guarantees Act 
does not apply. If you acquired the Product in Australia and if Datamed breaches a condition or warranty implied under any 



DSND01 Service Manual  

 

34 Appendix B – End User License Agreement | Datamed LLC 

 

law which cannot lawfully be modified or excluded by this EULA then, to the extent permitted by law, Datamed’s liability is 
limited, at Datamed’s option, to: (i) in the case of the Product: a) repairing or replacing the Product; or b) the cost of such 
repair or replacement; and (ii) in the case of support services: a) re-supply of the services; or b) the cost of having the 
services supplied again. 

Should you have any questions concerning this EULA, or if you desire to contact Datamed for any reason, please use the 
address information enclosed in this Product to contact Datamed directly or visit Datamed on the World Wide Web at 
http://www.datamed.com. 

 
EULA Rev L 
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